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* Why scripting

« pvbatch and pvpython

« The Python GUI tools

» Accessing a Python Shell

* Create a pipeline

« Python in paraview: The paraview.simple module

* Trace recording

* Macros

» Save ParaView state as a Python script

* Hands-on Python Scripting in ParaView
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l Why Scripting ' VISUALIZATION

http://www.paraview.org/Wiki/ParaView/Users Guide/Scripting ParaView

« Automate repetitive tasks (several similar data-sets)
« GUI is not useful or unavailable (batch execution)

 In-situ visualization or co-processing (computing+post-processing
at run-time)

The ParaView client provides an easy-to-use GUI in which to visualize data with the
standard window, menu, and button controls. Driving ParaView with a mouse is
intuitive, but is not easily reproducible and exact as is required for repetitive
analysis and scientific result reproducibility. For this type of work, it is much
better to use ParaView's scripted interface. This is an an alternative control path
that works alongside of, or as a replacement for, the GUI.
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pvbatch - pvpython

« Paraview contents 2 command lines able to run a python script:
— pvpython;
— pvbatch;

The differences is that:

— pvpython is equivalent to the paraview client where the
python interpreter plays the role of the GUI (interactive,
serial);

— pvbatch: is equivalent to the paraview server where the
commands are executed from the python script in the server
instead then from a socket plugged to a paraview client
(parallel)
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The Python GUI tools

http://www.paraview.org/Wiki/Python GUI Tools

If ParaView has been compiled with the Python wrapping, some
advanced features become available to the user such as:

Accessing a Python Shell
Trace recording

. Macros
Save ParaView state as a Python script

A OWN -

Those features can be reached from the Tools menu for the Shell
and Trace access.
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Accessing a Python shell

http://www.paraview.org/Wiki/ParaView/Python Scripting

The python interpreter is already runnable from paraview (under
Tools > Python Shell) to perfom interactive applications

I Python Shell (2 [ =]

Python 2.7.3 (defaultc, Sep 23 2014, §) [M5C +.1500 32 bit (Intel)] on win32 &
>»> from paraview.simple import # ]
paraview version 4.2.0

¥y dir()

['"AMRConnectivity', '"AMRContour', 'BEMRCutPlane', 'AMRDualClip', 'AMRFragmentIntegration', 'AMRFragmentsFilter', 'AMRGaussianPulseScource', 'AVSUCDReader',
'AddCameralink', "AlltoN', 'AnimateReader', "AnimationCueBase', 'BEnimationScene', 'AnimationSceneImageWriter', 'AnnotateGlobalData', 'AnnotateTime",
'EnnotateTimeFilter', 'AppendAttributes', 'AppendDatasets', 'AppendGeometry', 'Arrow', 'AssignLookupTable', 'Axes', "BYUReader', 'Balance', "BlockScalars',
'"BlockSelectionSource', 'BooleanEeyFrame', 'Box'", 'CMLMoleculeReader', 'CS5VReader', 'CSVWriter', 'CTHSurface', 'CacheKeeper', 'Calculator', '"CamerafnimationCus'
'CameraKeyFrame', 'CellCenters', 'CellDatatoPointData', "Clean', "CleanCellstoGrid', 'CleantoGrid', 'ClearSelection', 'ClientServerMoveData', 'Clip',
'ClipClosedSurface', 'ClipGenericDataset', 'ColorBy', 'ColorByArray', 'ComparativefnimationCue', 'CompositeDatalDSelectionScurce', 'CompositeKeyFrame',
'ComputeDerivatives', 'Computefuartiles', 'Cone', 'Connect', 'Connectiwvity', 'ContingencyStatisties', 'Contour', "ContourGenericDataset',
'ConvertAMRdatasettoMultiblock', 'ConvertSelection', "CreateZ2DRenderView', 'CreateBarChartView', 'CreateComparativeBarChartView', 'CreateComparativeRenderView',
'CreateComparativeXYPlotView', 'CreateLookupTable', 'CreateParallelCoordinatesChartView', 'CreatePiecewiseFunction', 'CreateRenderView', 'CreateScalarBar',
'CreateView', 'CreateWriter', 'CreateX¥PlotView', 'Crop', 'Curvature', 'Cylinder', '"D3', 'DEMReader', 'DICCMReaderSingleFile', 'DICCMReaderdirectory',
'DataCbjectGenerator', '"DataSetCS5VWriter', 'DataSetWriter', 'Decimate', 'Delaunay2D', 'Delaunay3D', 'Delete', 'DescriptiveStatistics', 'Disconnect', 'Disk’',
'DistributedTrivialProducer', 'ENZCAMRParticlesReader', "Elevation', 'EnSightMasterServerReader', '"EnSightReader', 'EnSightWriter', 'EnzoReader',
"ExodusITReader', 'ExodusIIWriter', 'ExponentialKeyFrame', 'ExportWView', 'ExtractAMRBlocks', 'ExtractAttributes', 'ExtractBagPlots', 'ExtractBlock',
'"ExtractCTHParts', 'ExtractCellsByRegion', 'ExtractEdges', '"ExtractGenericDatasetSurface', 'ExtractLewel', "ExtractLocation', 'ExtractSelection',
'"ExtractSelectioninternal’', 'ExtractSubset', 'ExtractSurface', 'FFTCfSelectionCverTime", 'FLASHAMRParticlesReader', '"FacetReader', 'FeatureEdges', 'FindSource',
"FindView', 'FindViewOrCreate', 'FlashReader', "FlattenFilter', 'FluentCaseReader', 'FrustumSelectionSource', 'GaussianCubeReader', 'GaussianResampling’',

%]
%]
%]
-
%]
o

m
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create an object, shrink and render it

http://www.paraview.orqg/Wiki/ParaView/Python Scripting#Creating a Pipeline
0 W 2 [ @socoor [ pyoion chen (% | =] @ e G
Ve P =

@ >»>» from paraview.simple import *
>»> # Create a cone and assign it as the active object

Yipeline Browser >>»> Cone ()
T <paraview.servermanager.Cone object at 0x0B18B5S50> Rendel
ﬁ builtin: >»> # Set a property of the active object

>»> SetProperties (Resolution=32)
>>> # Apply the shrink filter to the active object
>>> # Shrink is now active
>>>Shrink ()
Traceback (most recent call last):
File "<console>™, line 1, in <module>
NameError: name 'hrink' is not defined
>»» Shrink()
File "<console>™, line 1

Properties Information ASh:ink 0

‘roperties IndentationError: unexpected indent

>»> Shrink()

<paraview.servermanager.Shrink object at 0x103CC470>

>>> # Show shrink

>»> Showi()
<paraview.servermanager.UnstructuredGridRepresentation object at
O0x10E62DF0>

>»» # Render the active view

>>> Render ()

<paraview.servermanager.RenderView object at O0x109CCABO>
et

+ Apply D Resq

Search ... (use Esc to clear text)

‘ = Properties (Shrink1)

Shrink Factor - D

‘ = Display (UnstructuredGridRepresentation

RepresentationISurface [ Run Script ] l Clear ] l Reset

Coloring

| @ solid Color = =

Or run the script cone.py
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The paraview.simple module ) VISUALIZATION
http://www.paraview.org/Wiki/ParaView/Python Scriptinq#paraview.simple Module

« The first thing any ParaView Python script must do is load the paraview.simple module.
from paraview.simple import *
Or in a save way using the try/except construct
try: paraview.simple
except: from paraview.simple import *

« This command is automatically invoked in the ParaView GUI tracing facility, but it must
add when you are writing a script to be used in batch. The simple module can be loaded
from Python interpreters running in several applications:

pvpython
Pvbatch
Paraview (Tools > python shell)
External Python interpreter
 The paraview.simple module contains a function for every source, reader,filter, and writer

with off-course the same name as shown in the GUI menus but with spaces and special
characters removed.

« Each function creates a pipeline object, which will show up in the pipeline browser (with
the exception of writers), and returns an object that is a proxy that can be used to query
ClNECa}xnd manipulate the properties of that pipeline object.
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Batch scripting in python

Python 2.7.3 (default, Feb 4 2013, 20:52:48) [MSC v.1500 64 bit (AMD64)] on win32

>>> paraview version 3.98.1-RC2

from paraview.simple import *

>>> help(Sphere)

Help on function CreateObject in module paraview.simple:

CreateObject(*input, **params)

The Sphere source can be used to add a polygonal sphere to the 3D scene. The output of the Sphere source is polygonal data with point normals defined.
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This function creates a new proxy. For pipeline objects that accept inputs, all non-keyword arguments are assumed to be inputs. All keyword arguments are assumed to be property,value pairs

and are passed to the new proxy.

>>> help(Show)
Help on function Show in module paraview.simple:
Show(proxy=None, view=None, **params)

Turns the visibility of a given pipeline object on in the given view.

If pipeline object and/or view are not specified, active objects are used.

>>> help(Render)
Help on function Render in module paraview.simple:
Render(view=None)

Renders the given view (default value is active view)

>>> help(Hide)
Help on function Hide in module paraview.simple:
Hide(proxy=None, view=None)

Turns the visibility of a given pipeline object off in the given view.

If pipeline object and/or view are not specified, active objects are used.
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Batch scripting in python

>>> mysphere=Sphere()

>>> dir(mysphere)

[CellData’, 'Center’, 'EndPhi’, 'EndTheta’, 'FieldData’, 'FileNameChanged', ‘GetCellDatalnformation’, ‘GetDatalnformation’,
'GetFieldDatalnformation’, 'GetPointDatalnformation’, 'GetProperty', 'GetPropertyValue', 'Initialize’, 'InitializeFromProxy', 'ListProperties’,

'‘Observed’, 'ObserverTag’, 'PhiResolution’, 'PointData’, ‘Port’, 'Radius’, 'SMProxy’', 'SetPropertyWithName', 'StartPhi', ‘'StartTheta’,
"ThetaResolution', 'UpdatePipeline’, 'UpdatePipelinelnformation’, ' _Proxy _ConvertArgumentsAndCall',' Proxy _GetActiveCamera’,

' Proxy__LastAttrName','_Proxy__Properties',’ _class_ ',' del ' ' delattr_',' dict '' doc_'"' eq_' "' format_ ' ' getattr ',
' getattribute_ ',' getitem__',' hash_',' init_'' iter_'' module_'' ne_'' new_ ' ' reduce '' reduce ex_'' repr_ ',
' setattr__',' sizeof '’ str_',' subclasshook_',' weakref ', 'add_attribute']

>>> print mysphere.Radius

0.5

>>> print mysphere.PointData

<paraview.servermanager.FieldDatalnformation object at 0x0000000017BBAC50>
>>> Render()

<paraview.servermanager.RenderView object at 0x0000000018044FD0>

>>> Show()

<paraview.servermanager.GeometryRepresentation object at 0x0000000017A50748>

>>>
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Trace record

1. Starttracing

2. Build your pipeline as usual

3. Stop tracing and save the trace file with
a name

M ParaView 4.2.0 32-bit EI‘E

File Edit View Sources Filters Tools Catalyst Macros Help
pE B wa F ?2&k KaA> DB o 1

B2 (esmicr o) e JRHEsdR2 a3 [Fleea
VDO RIEOEET P ® 1] eveciomon [ O° & O &
Pipeline Browser M untitied.py* - Seript Editor (=]

T S "
B builtin: File  Edit Renderviewl [I](8][O](x]
@ W conet $57# import the simple moduls from the paraview
\ from paraview.simple import *

@ n ###¢# disable automatic camera reset on 'Shovw'
paraview.simple. DisableFirstRenderCameraReset ()

# creats nev 'Cons'

conel = Cone()

Properties conel.Resolution = &

conel.Radius = 0.5

Properties conel.Height = 1.0
- conel.Center = [0.0, 0.0, 0.0]
=" Apply conel.Direction = [1.0, 0.0, 0.0]

conel.Capping = 1
Search ... (use Esc to clear text)
# get active view

renderViewl = GetActiveViewCrCreate ('RenderView")

t fo.

| = Properties (Clipl)

wing to set a specific view size

Clip Type # renderViewl.ViewSize = [654, 461]

Show Plane

# show data in view

Origin 0 conelDisplay = Show(conel, renderViewl)

Mormal 1

[ X Normal I Reset Bounds

[ Y Normal I

[ 7 Normal l N

Bl . celal=|% m ' i
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You can use the traced file in two ways:

- As a macro

- As a python script using the GUI
- As a python script in batch

CINECA\
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Macro

» Macros allow the user to define a Python script as built-in actions that become
accessible from the Macros menu or directly inside the Toolbar.

» Once a local file is defined as a macro (by clicking-on Create New Macro) the
given file is copied inside the user specific ParaView directory. No reference is kept
to the original file. Therefore, if you keep editing the original file, the changes
won't affect the macro itself.

» The macros list is built dynamically at the ParaView start-up by listing the
content of the ParaView/Macros directory, as well as the user specific
ParaView/Macros directory. Note: if you want to rename a macro, rename the file
in one of the given directory.
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To save the state as a Python script, go to the File menu and choose Save State
without forgetting to switch the file type to be Python *.py.

File Edit View Sources Filters Tools Macros Help

Python Shell (x|

>>> from paraview.simple import *
paraview version 4.1.0
>>>

Ell

[RunScriptH Clear ” Reset ]

(o] )

= Display
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Python 2.7.2 (default, Jan 12 2014, 23:33:44)
[GCC 4.1.2 20061115 (prerelease) (Debian 4.1.1-21)] on linux2

Look in:

T

L/gpfslscratchluserinternaIlispissoOlparaviewltutoriallbasicdata/n[v] €« 5 4 B

Home

B motorbike
[ pitzdaily
mixer2D

RoomCFD

data_morphed_¢

Filename
B motorbyke script.py

File name:

[ motorbyke_script.py ] pe

Files of type: | Python Script (*.py) v || Cancel
()
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Recording a Paraview pipeline

A similar (but different) solution to launch a pipeline in an
automated way is to:

— record a test

and then to:

— Play a test
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Workout

Build a script to process several VTK dataset according to the

pipeline obtained during the previous tutorial
Launch the script over the dataset to archive different animations

Record a test and play it for the above mentioned operations
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